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Preface

This User Guide has been implemented by Boot & Work, S.L.

working under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.
Refer to the controller’s User Guide regarding wiring considerations.

o Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.
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e The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

® In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

® Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le controleur.

® Reportez-vous au Guide de l'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

® Les automates de la famille M-Duino sont des contréleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

e En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT
BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF
PERSONS, AS THEY ARE NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING
THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED TO ADDRESS THE RISKS, NEVER USE THE
INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use of the
product.

The following are some examples of applications for which particular attention must be given.
This is not intended to be an exhaustive list of all possible uses of the products, nor is it
intended to imply that the uses may be suitable for the products:

Systems, machines, and equipment that could present a risk to life or property.
Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equipment, and
installation subject to separate industry or government regulations.

e Qutdoor wuse, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification
documents identifying ratings and limitations of use that apply to the products. This
information by itself is not sufficient for a complete determination of the suitability of the
products in combination with the system, machine, end product, or other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the
catalogue and the associated technical documentation. If third-party products and components
are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It must
respect the permissible ambient conditions. You should also follow the indications and
warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated
by qualified personnel for the task entrusted and observing what is indicated in the
documentation corresponding to it, particularly the safety instructions and warnings included
in it. Due to their training and experience, qualified personnel are in a position to recognize
risks resulting from the handling or manipulation of such products / systems and to avoid
possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even
when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining
suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL
SHIELDS’s test conditions, and the users most correlate it to actual application requirements.
Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.

Errors and Omissions
The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.
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The control and drive components of an Industrial Shields PLC are approved for industrial and
commercial use in industrial line supplies. Their use in public line supplies requires a different
configuration and/or additional measures. These components may only be operated in closed
housings or in higher-level control cabinets with protective covers that are closed, and when all
of the protective devices are used. These components may only be handled by qualified and
trained technical personnel who are knowledgeable and observe all of the safety information
and instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU Machinery
Directive, the machine manufacturer must consider the following residual risks associated with
the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,
maintenance, and repairs caused by, for example: — Hardware defects and/or software errors in
the sensors, controllers, actuators, and connection technology — Response times of the
controller and drive — Operating and/or ambient conditions not within the scope of the
specification — Condensation / conductive contamination — Parameterization, programming,
cabling, and installation errors — Use of radio devices / cellular phones in the immediate
vicinity of the controller — External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for
example: — Component malfunctions — Software errors — Operating and/or ambient conditions
not within the scope of the specification — External influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions — Influence of
electrostatic charging — Induction of voltages in moving motors — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to
people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the
system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials
and workmanship for a period of one year (or other period if specified) from date of sale by
Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,
REGARDING MERCHANABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE
OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE
PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR
STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, REPAIR OR OTHER
CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT
THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT
SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

RECOGNIZED
COMPONENT
o™ Conforms to UL Std. 61010-1
Conforms to UL Std. 61010-2-201
(o] us Certified to CSA Std. C22.2 No. 61010-1
LISTED Certified to CSA Std. C22.2 No. 61010-2-201
Intertek
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO 21 I/Os PLUS product

1.1 Zone - Nomenclature
The nomenclature shown in this point will be used in the whole User Guide, so it is important
to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from
below and B the shield from above. It has 2 zones (A, B):

e The inputs in the zone B are named 10.X, being X any number suitable in the Shield.
Outputs are named as Q0.X.

10
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1.2 Zone Distribution

Y )

ZONEA |—=| ZONEB

Communication

|
i

Analog

Digital

:

The distribution of the different features that provide the M-Duino 21 1/Os PLUS is the
following one:

Shield B Zone
13 Inputs

(13 Digital inputs, 6
of which can work as
Analog Input)

Analog Shield

8 Outputs

(8 Digital Outputs, 3
of which can work as
Analog Output)

11
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1.3 A Zone Features

Shield

Communication
Shield

Rev. 3:12-12-2024

A Zone
(1x) Ethernet
(1x) USB
(1x) 12€
(3x) TTL
(1x) RS-232
(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port
(1x) RTC

(1x) uSD Socket

1.4 Mechanical dimension

1195

12
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1.5 General Features

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE

Input Voltage

Input rated voltage

Rated Power
| max.
Size
Clock Speed
Flash Memory
SRAM
EEPROM

Communications

USB consideration!

An/Dig Input 10bit
(0-10Vcc)

Digital Isolated Input
(24Vcc)

* Interrupt isolated Input
HS (24Vcc)

Analog Output 8bit
(0-10Vcc)

Digital Isolated Output
(24Vcc)

A+B Zone

12 to 24vdc

24 Vdc
30w
1.5A

101x70.1x119.5
16MHz

256KB of which 8KB used by bootloader

8KB
4KB

12C — Ethernet Port — USB — RS485 — RS232 -- SPI — (2x)

Rx, Tx (Arduino pins)

Only meant for uploading or debugging, not always
connected as a serial in a project!

0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

5 to 24Vdc
I min: 2to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

0 to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I max: 70 mA
Galvanic Isolation

Diode Protected for Relay
Rated Voltage: 24Vdc

Rev. 3:12-12-2024

Fuse protection (2.5A)
Polarity protection

Max232-Max485-W5500

Cannot be working in a final
application

Imax 24Vdc: 410 mA

13
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Digital Isolated Output
Relay

PWM Isolated Output
8bit (24Vcc)

Expandability

220V Vdc
| max: 5A
Galvanic Isolation
Diode protected for Relay

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

12C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

Rev. 3:12-12-2024

14
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Rev. 3:12-12-2024

2 Technical Specifications

2.1 General Specifications

Power supply
voltage

Operating
voltage range

Power
consumption

External
power supply

Item

DC power supply

DC power supply

DC power supply

Power supply
voltage

Power supply
output capacity

Insulation resistance

Dielectric strength

Shock resistance

Ambient temperature (operating)

Ambient humidity (operating)

Ambient environment (operating)

Ambient temperature (storage)

Power supply holding time

Weight

M-Duino PLC Arduino Ethernet 21 I/Os Analog/Digital PLUS

12 to 24Vdc

11.4 to 25.4Vdc

30W max.
24Vdc ===
700Ma

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all
the external AC terminals and the protective ground terminal.

80m/s%in the X, Y and Z direction 2 times each.

02 to 602C

10% to 90% (no condensation)

With no corrosive gas

-202 to 602C

2ms min.

378g max.

2.2 Performance Specification

Arduino Board

Control method

1/0 control method

Programming language

Microcontroller

Flash Memory

Program capacity (SRAM)
EEPROM
Clock Speed
Clock Speed

ARDUINO MEGA 2560
Stored program method

Combination of the cyclic scan and immediate refresh processing methods.

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

ATmega2560

256KB of which 8KB are used by the bootloader
8KB

4KB

16MHz

16MHz

15
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2.3 Symbology

Rev. 3:12-12-2024

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino
Ethernet 21 1/Os Analog/Digital PLUS:

Symbol

n
1
X
€
/N
;

Standard No. /
Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

2004/108/EC /
Electromagnetic
Compatibility

ISO 7000/ Graphical

symbols for use on
equipment

ISO 7000/ Graphical

symbols for use on
equipment

Standard Reference

No. / Symbol Title

5031 / Direct
Current

5032 / Alternating
Current

5130/ Pulse General

5017 / Earth,
Ground

5115 / Signal lamp

CE Marking

04348/
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only; to
identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant
terminals

To identify the control by which a
pulse is started.

To identify an earth (ground)
terminal in cases where neither
the symbol 5018 nor 5019 is
explicily required.

To identify the switch by means
of which the signal lamp(s) is
(are) switched on or off.

CE marking indicates that a
product complies with applicable
European Union regulations

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

To indicate hazards arising from
dangerous voltages

16
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3 Precautions

Read this manual before attempting to use the M-Duino PLC Arduino Ethernet 21 1/Os
Analog/Digital PLUS and follow its descriptions for reference during operation.

3.1 Arduino Board

The M-Duino 21 1/Os PLUS PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this
manual.

Before using M-Duino under different conditions from what has been specified in this manual
or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles,
combustion systems, medical equipment, amusement machines, safety equipment and other
systems, machines, and equipment that may have a serious influence on lives and property if
used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and
performance characteristics of M-Duino are sufficient for the systems, machines, and
equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operating the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

e Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.

17
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4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Network:

Sketrhbook: location:

€ \Users\Albert\Documents\Arduino Browse
Editor language: English (English) | (requires restart of Arduino)
Editor font size; 15

Interface scale: Automatic | 100 T %  (requires restart of Arduino)

Show verbose output during: [ compilation upload
Compiler warnings: None v

[Jpisplay line numbers

[Jenable code Folding

Verify cade after upload

[Juse external editor

Check for updates on startup

Update sketeh files to new extansion on save (.pds -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs: | http://apps. industrialshields. com/main/arduino /boards package_industrialshields_inde:  [C]

More preferences can be edited directly in the file
C:\Users\Albert\AppData\local\Arduinal S\preferences, txt
(edit only when Arduine is not running)

Ok Cancel

2. In Additional Boards Manager URLs write the following:

3. Press OK to save the changes.
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4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch_mar16a | Arduino 1.80
File Edit Sketch Tools Help

Auto Format
Archive Sketch

sketch_marls  Fix Encoding & Reload
Serial Monitor

id setup
Serial Plotter

WiFi101 Firmware Updater

Board: "M-Duino family"

Industrial Shields: "M-Duino 58+"

Port
PUE Y GetBoardInfo

) Programmer: “Arduino as ISP"
Bum Bootloader

Cul+T

Cl+Shift+M
Cl+Shift+L

> Boards Manager...
3 Arduino AVR Boards
Arduino Yin
Arduino/Genuino Uno
Arduino Duemilanove or Diecimila
Arduino Nano
Arduino/Genuino Mega or Mega 2560
Arduino Mega ADK
Arduino Leonardo
Arduino Leonardo ETH
Arduino/Genuino Micro
Arduino Esplora
Arduino Mini
Arduino Ethemet
Arduino Fio
Arduino BT
LilyPad Arduino USB
LilyPad Ardino
Ardtino Pro or Pro Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor
Ardino Gemma
Adafruit Circuit Playground
Ardtino Yiin Mini
Arduino Industial 101
Linino One
Arduino Uno Wiki
Industrial Shields boards
Ardbox family
® M-Duino family

5. Search for “industrialshields” on the browser.

Rev. 3:12-12-2024

@ Boards Manager

4 Type Al ~ | industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

Mare info

~ Install

Close
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

@ ESP32AccessPoint | Arduino 1.89 - X
File Edit Sketch Tools Help

Auto Format cul+T
Archive Sketch
Fix Encoding & Reload

Manage Libraries. Ctrl+Shift+l ~
Serial Monitor Ctri+Shift+M
Serial Plotter Ctrl+Shift+L

WFi101 / WiFiNINA Firmware Updater

Board: "M-Duino family” 3 Boards Manager..
Model: "M-Duino 19R+" B R
Port MStack-FIRE
Get Board Info MSStick-C
Programmer: “Arduino Gemma" i EIlpEER

Heltec Wifi Kit 32
Heltec Wifi LoRa 32
Heltec Wifi LoRa 32(2)
Heltec Wireless Stick
ESPectro32
Microduino-CoreESP32
ALKS ESP32

WiPy 30

BPI-BIT

Silicognition WESP32
T-Beam

D-duino-32

Lopy

Lopy4

OROCA EduBot

ESP32 FM Devkit
number to 80 Frog Board ESP32

Al Thinker ESP32-CAM
SparkFun LoRa Gateway 1-Channel

Burn Bootloader

with your network c:
ssid = "ESP3;
password = "12345

server port
© server(80);

the HITP request Industrial Shields ESP32 modules
WiFi module

Industrial Shields boards

“Ardbox GPRS family
Ardbox Wi/BT family
@ M-Duino family

W-Duino family on COMA3.

Once it is selected M-Duino Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

@ ESP32AccessPoint | Arduino 1.89 - X
File Edit Sketch Tools Help

Auto Format cul+T
Archive Sketch
Fix Encoding & Reload

Manage Libraries... Ctrl+Shift+l a
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

WiFi101 / WIFiNINA Firmware Updater

Board: "M-Duino family’ >
Model: "M-Duino 21+"
Port

Get Board Info

M-Duino 19R+
M-Duino 21
JJ81 M-Duino 21+

M-Duino 38AR+

Programmer: “Arduino Gemma"
Bum Bootloader

M-Duino 42
M-Duino 42+
M-Duino 50RRA+
M-Duino 53ARR+
M-Duino 54ARA+
M-Duino STAAR+
M-Duino S7R
M-Duino 57R+
M-Duino 58
M-Duino 58+

//ESE32 code

// Replace with your network c
har* ssid
char* password =

// Set web server port number to 80

W server(80) ;

// Variable to store the HTTP request
String header;

M-Duino family on COMA3.

Also there are some examples of programming in File -> Examples -> M-Duino Family.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

htt ithub.com/Industrial-Shields
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5 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino 21 1/0Os PLUS uses USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino Family

@ sketch_aug21a | Arduino 1.89 . [=] X
File Edit Sketch Tools Help

Auto Format T
Archive Sketch

Fix Encoding & Reload

Manage Libraries.. Ctrl+Shifts1
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl=Shift+L

} WiFi101 / WIFiNINA Firmware Updater

Board: "M-Duino family” 3 Boards Manager..
Model: "M-Duino 42+" ) .

Port MSStack-FIRE

) Get Board Info MSStick-C

ODROID ESP32

Heltec Wifi Kit 32
Heltec Wifi LoRa 32
Heltec Wifi LoRa 32(2)
Heltec Wireless Stick
ESPectro32
Microduino-CoreESP32
ALKS ESP32

WiPy 30

8PI-BIT

Silicognition WESP32
T-Beam

D-duino-32

LoPy

LoPy4

OROCA EduBot

ESP32 FM Devkit

Frog Board ESP32

Al Thinker ESP32-CAM
SparkFun LoRa Gateway 1-Channel

Programmer: "Arduino Gemma" 3
Burn Bootloader

Industrial Shields ESP32 modules
Wifi module

Industrial Shields boards
Ardbox family
Ardbox GPRS family
Ardbox WiFi/BT family
& M-Duino family.

M-Duino GPRS family
M-Duino WiFi/BT family

M-Duina family, W-Duino 4
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- Select the correct M-Duino Board (M-Duino 21+).

@ ESP32AccessPoint | Arduino 1.8.9

File Edit Sketch Tools Help

Auto Format CrlsT
Archive Sketch

Fix Encoding & Reload

Manage Libraries. Ctrl+Shift+l
Serial Monitor Curl+Shift+M
Serial Plotter Ctrl+Shift+L

WiFi101 / WIFiNINA Firmware Updater

Boar

-Duino family” >
Model: "M-Duino 21+"

M-Duino 19R+
M-Duino 21
M-Duino 21+
M-Duino 38AR+

Get Board Info

Programmer: "Arduino Gemma™
Burn Bootloader

M-Duino 38R+
M-Duino 42
M-Duino 42+
M-Duino 50RRA+
M-Duino 53ARR+

//ESP32 code M-Duino 54ARA+
M-Duino 57AAR+
// Load Wi-Fi library M-Duino STR
#include <WiFi.h> M-Duino 57R+
M-Duino 58
/ M-Duino 58+

ith you

// Replace

con r* ssid

password = "123456789";

€ number t
server(80) ;

// Variable to store the HITP request

M-Duino family on COMA3

- Select the correct port.

© sketch_mar16a | Arduino 1.80
File Edit Sketch Tools Help

Auto Format CoieT
Archive Sketch
_maris  FixEncoding & Reload
(0 sery | SenalMonitor Ctl+ShiftsM —
Serial Plotter CuleShiftsl

put y

WIFi101 Firmiware Updater

Boarct "Arcbox family" >
Industrial Shields: “Ardbox Analog" >
* Port 3 Serial ports
’ GetBoard Info COM13 (Arduino Leonardo)
) Programmer: "Arduino as ISP >

Burn Bootioader

Ardhox famil, Ardbox Analog on COM34

~ g 1530 B

22



Ref. IS.MDUINO.21+ Rev. 3:12-12-2024

6 How to connect PLC to power supply

M-Duino 21 1/Os PLUS PLC is 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

Make sure that the live and GND connector of the power supply match the PLC.
Make sure that the power supply mains output is not higher than 24Vdc.

POWER SUPP LTl

GND |
24WVdc _&

GHND I

I —f ped ATl |

| I ———

Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vvdc

-2.5A
-30W

Industrial Shields power supplies provide parallel operation,

overvoltage protection, and overcurrent protection. There is
a LED inductor for power status, the power supply is certified
according to UL.

f]

thao

0 4. 8

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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7 M-Duino 21 I/Os PLUS Pinout

7.1 A Zone connection

M-Duino
Connector

SCL
SDA
RX0
TXO0
RX1
™1
TX

Z-
Y+
B-
A+
PIN3
50 SO
518l
52 SCK
Reset
Vin5
PIN2
GND
GND
24Vdc

Base

(common unit)
A Zone

Arduino
Pin

Reset
Vin5

Function

12C/SS
12C/SS
RX0/SS
TX0/SS
RX1/SS
TX1/SS
RX2(serial 2)
TX2(serial 2)
RS485
RS485
RS485
RS485
Arduino Pin
SPI
SPI
SPI
SPI
5V
Arduino Pin
Gnd
Gnd
Power Supply

s

ARef
sQw
IORef
3.3Vdc
5vdc
Gnd

SCL ]
SDA

El
@
3

Rev. 3:12-12-2024

Configuration Switch® (see section 8 for
configuring the communications.,
Enabling communications disables some
1/0s)

Communication Pins

Power supply connectors
(24Vde — GND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

M-Duino
Connector

AREF
IOREF2
IOREF1

7Vdc

GND
3.3Vdc
GND
5Vdc
GND

Base

(common unit)
A Zone

Arduino
Pin

AREF
IOREF2
IOREF1

7Vdc
GND
3.3Vdc
GND
5Vdc
GND

Function

Arduino PIN
Arduino PIN
Arduino PIN
GND
Arduino PIN
GND

GND

=

[

]

ON

OFF
SCL/I126
SDA/I25
Rx1/11.6
Tx1/11.5

Pin3/106
Pin2/10.5
D53(SD)
FD rs4ss HD

OFF ON
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é 8
N % § z E w
Ll <E3V P
T E S 4
E 82 °g O /8 48
§ <" peser/ UBBProgam | £ R
FE RTCEBatery [gn’zmn _." *45D Socket[J .'I ".
- [ ".
- i \
Ethernet Arduino -~ / Power \
Connector Reset button / \
USE programmer Autoreset
connector

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using serial
communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield) I
B Zone T
Anarc;gt
0-10vde
Digital
M-Duino Arduino . 5 - 24vde
. Function .
Connector Pin Digital:
5-24vdc
GND —|
10.12 59 Analog/ Digital In 1012 —o£Fk
10.11 58 Analog/ Digital In ;glg %
10.10 57 Analog/ Digital In 0.9 —To AnalogDigital Inputs
10.9 56 Analog/ Digital In 0.8 —ofTK
10.8 55 Analog/ Digital In ‘t‘i‘zsﬁ
10.7 54 Analog/ Digital In I0.6/INT 1+ ,
(-)10.6/INTL _ GND 10.6 () I05/NTDY Interrupt Inputs (isolated)
10.6/INT1? 3 Interrupt 1 In 10-5/INTO-
(-)10.5/INTO - GND 10.5 ()10.4—
10.5/INTO* 2 Interrupt O In ‘(?)—'TO aj/
(-)10.4 - GND 10.4 03 o
10.4 26 Digital Input (-)10.2—
(103 - GNDI0.3 Sioa Digital Inputs (isclated)
10.3 25 Digital Input 01 o
(-)10.2 - GND 10.2 ‘Eé)éﬂ 0:/
10.2 24 Digital Input ’ H
(-)10.1 - GND 10.1 B
10.1 23 Digital Input
(-)10.0 - GND 10.0
10.0 22 Digital Input
Top Zone
] |
ehife) ogg o/qg o 0lo o¢9 :I_
Led indicator 1/Os state
B Zone LalNe Configuration Switch®
a7 (see section 8 to select the
55laos correct configuration for outputs).
M-Duino Arduino Function .
Connector Pin —2igtal
Q/fVde
~Ybamwm-
Qivde
GND GND GND - Analog Outpuls
A0.7* 6 Analog Out A7
Ao.6! 5 Analog Out 5 hos Voltage Supply/Reference for
A0.5 4 Analog Out § Digi 1
2 igital PWh Qutputs (isolated
Q/Vdc - External Isolated Out Vdc g Fa/vac o P [ }
coMm(-) - External Isolated Out £ o .
Qo.7* 6 GND 8 Qo6 PWiM/Digital Outputs
Q0.6 5 Digital/PWM Out 3 _ -
Q0.5 4 Digital/PWM Out sst Q03
Q0.4 40 Digital/PWM Out 237 gg%
Q0.3 39 Digital Out g 235 Q00
Q0.2 38 Digital Out HoZg8 |
Q0.1 37 Digital Out
Q0.0 36 Digital Out
Digital Out

! See section 8 to select suitable switch configuration to enable these connections.
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8 Switch Configuration

8.1 A Zone: Communications

o —p

LEFT ZONE
Switch
ON
D ZONE
SCL/12.6 NC
SDA/12.5 NC
C ZONE
RX1/11.6 NC
TX1/11.5 NC
B ZONE
Pin 3/10.6 10.6
Pin 2/10.5 10.5
uSD & RS-485
D53(SD) NC

FD RS-485 HD HD

OFF

SCL
SDA

RX1
X1

Pin 3
Pin 2

SD
FD

OFF ON

SCL/NC
SDA/NC
Rx1/NC
Tx1/NC

Pin 3/10.6
Pin2/10.5
D53(SD)
FD RS485 HD

OFF ON

Rev. 3:12-12-2024

4. SCL/NC: Always at OFF Position! Switch has to be OFF position to enable SCL, never ON
because in this position is NC (Not Connected).

3. SDA/NC: Always at OFF Position! Switch has to be OFF position to enable SDA, never ON
because in this position is NC (Not Connected).

2. RX1/NC: Always at OFF Position! Switch has to be OFF position to enable RX1 never ON
because in this position is NC (Not Connected).

1. TX1/NC: Always at OFF Position! Switch has to be OFF position to enable TX1, never ON
because in this position is NC (Not Connected).
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4. Pin 3/10.6: Choosing between Pin 3 or the input 10.6. If this switch is ON, it enables the 10.6
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.6.

3. Pin 2/10.5: Choosing between Pin 2 or the input 10.5. If this switch is ON, it enables the 10.5
input and disables the Pin 2. If this switch is OFF, it enables Pin 2 and disables 10.5.

2. D53 (SD): Always at OFF Position! Switch has to be OFF position to enable the Chip Select of
the microSD card, never ON because in this position is NC (Not Connected).

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables
HD.

OFF ON
LEFT ZONE
SWITCH ON OFF NC
NC - - NC
NC - - RTC SCL
RTC SDA RTC -

1. RTC SDA: This switch enables the communication to communicate with the RTC using 12C.
Having this switch in ON mode activates this communication, whereas if it is in OFF mode it
disables the 12C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC using 12C.
Having this switch in ON mode activates this communication, whereas if it is in OFF mode it

disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in ON
mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in ON
mode or OFF mode.

28



Ref. IS.MDUINO.21+ Rev. 3:12-12-2024

8.2 B Zone Switches

B ZONE
SWITCH ON | OFF
NC - -
Q0.7 Q0.7 | A0.7
Q0.6 Q0.6 | AO.6
Q0.5 Q0.5 | A0.5

OFF ON

NC NC
AD.7 Q0.7
A06 Q0.6
A05 Q0.5

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with AX.X, being X any number of the tables above.

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with AX.X, being X any number of the tables above.
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9 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As this pins are directly
connected to the Arduino Mega board they are not as well protect as the normal inputs. These
pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 8) and some extra
considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 I2C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is stablished by default in these
pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up inputs.

*IMPORTANT: 12.5 & 12.6 are not pull-up inputs although they are referred to the 12C pins
(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the
same behaviour as the other inputs.

9.2 Serial 0 - RX0/TXO0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time. When the PLC is not installed, the USB communication is normally required for
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debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.3 Serial 1 - RX1/TX1

These pins are only referred to the inputs 11.5/11.6. If the switch configuration is in OFF position
the pins RX1/TX1 will be available. If not using the Serial 1 interface these pins can work as
digital, either input or output.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.4 SPI - MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.5 Pin 2/Pin 3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF position
the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 8). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.312C

12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino 21 1/Os PLUS. The
pull-up resistor is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the I12C communication.

Switch ON OFF
D ZONE

SCL/12.6 12.6 SCL

SDA/I2.5 12.5 SDA
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To enable 12C the switches SCL/I12.6 & SDA/12.5 must be set to OFF mode. In this mode the
inputs are totally disabled and the 12C is now enabled.

Industrial Shields does not provide any library to implement the 12C as it can be used with the
standard library of Arduino called Wire.

10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 518l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

In order to use the TTL pins the configuration of the switches have to be the following one:

Switch Analog Shield
ON OFF

C ZONE
RX1/11.6 11.6 RX1
TX1/11.5 11.5 TX1

If the switches RX1/11.6(11.1) & TX1/11.5(11.0) are in OFF mode, the RX1/TX1 will be enabled. In
order to use TTL3 these switches must be in OFF mode.

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with
Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the
M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino
Mega pin 10).
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10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE

SWITCH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable

EE - - the 12C wires to the RTC. If they are in OFF mode, the
RTC SCL R'}C : Arduino won’t communicate with the RTC.
RTC SDA RTC -
Switch

ON OFF I2C (SCL, SDA pins) must be enabled in order to

SCL/12.6 12.6 SCL communicate with the RTC. See section 11 12C to
SDA/I2.5 12.5 SDA enable it.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD
can’t be used.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

LEFT ZONE
Switch
ON OFF
usSD
D53(SD) Q2.0 D53(SD)
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Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors
ligne et en sécurité.
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11 Instructions for interconnection between Industrial

Shields controllers

11.1 RS-232 Communication:

- ~.

. M-Duino 21 l/Os \ [;}_‘Anotherlndustrial /
' PLUS ‘ | Shields PLC |

KRFC-6 Ferrite (4 Loops]
Tx 6“ 1Tx

SHIELDED CABLE

Ferrite KITA Ferrite KITA

o XXX ' GND
12/24V | @OOO( 12/24V

\.

]

11.2 RS-485 Communication:

11.2.1 Half Duplex

. M-Duino2110s ~ * Another Industrial ~
‘ PLUS " | Shields PLC |

KRFC-6 Ferrite (4 Loops)
A 0 E -A
SHIELDED CABLE
Ferrite KITA Ferrite KITA
GND | | 4 GND
12124V )OOG@ ‘ @OOOC 12124V
| \ J \

o

< \ > ¢

11.2.2 Full Duplex

. M-Duino 2110s ~ “_Another Industrial

-

/ \ 7
PLUS | Shields PLC
A Y
RS-485 \B( RS-485
p4
Ferrite KITA g ) CABLE Ferrite KITA
GND : SHIELDED CABLES | [ GND
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11.3 Ethernet

KRFC-6 Ferrite

Rev. 3:12-12-2024

Ethernet

M-Duino 21 1/0s
PLUS g -

Ferrite KITA

GND - |
12y X

: Another Industrial

Shields PLC

Fermrite KITA

GND
FHOOT G

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.
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12 I/0O technical details

Digital Output Waveform:

[T o ———1
v

DIGITALOUT

M 288ms

DIGITAL OUT

PWM OUTPOUT

CH1 % Z@Eml)

Rev. 3:12-12-2024
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Analog Out Turn On:

]

ANALDG OUT

CH1 £ @.@8u
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13 Typical Connections

GND ‘*} (-)10.0
52124V o o)1 10

SHIELDED CABLE
Ferrite KITA

S Rl S

SHIELDED CABLE / Dowrsoad B MDUING LAYOUT:

From:

B

Ferrite KITA
= 9 POWER

2724V B oomuwm

SHIELDED CABLE ,J Douniod oo MOURO LAYOUT:
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SHIELDED CABLE
2124V o o

Ferrite KITA
5

U )" e,

SHIELDED CABLE  /  Fewwwndesesesiom
< >

—m— 0.7

Ferrite KITA

SO - —

Dorsined Fre MOUING LAYOUT:

SHIELDED CABLE i* From: www industriaishisids. com \\
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0-10V
SHIELDED CABLE
a mm%m—- 0.7
GND
Ferrite KITA
GND '['B POWER
12724V B pomauanaoow

SHIELDED CABLE Duroed S MOURNO LAYOUT:
SN

DIGITAL ISOLATED QUTPUT

SHIELDED CABLE
Q/vde £\ 82724V
ALWAYS
CONNECTED
Ferrite KITA 000 ®
oo 1o POWER VOUT = @/ Vide
224V [ DIGITAL OUT

SHIELDED CABLEf oot mave s \_
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SHIELDED CABLE

Gﬂb{ﬁ

2124V

Ferrite KIT/

Rev. 3: 12-12-2024

VOUT = Q/Vde

SHIELDED CABLE

DIGITAL / PWM ISOLATED
OUTPUT

Ferrite KIT

" \
E
v [

Qlvde
COM (-)
A a0s
POWER
I DIGITALPWA OUT

* Sew the swilch
configutarion (ON)
f 512724V
{ o A
J ALWAYS
JU1 CONNECTED
® SHIELDED CABLE
VOUT = Q/ Vide
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* 500 the switch
configutanion [ON)
1 A
ALWAYS
Jun CONMNECTED
Ferrite KITA @
_“:[9] VOUT = 0./ Vido
12124V
SHIELDED ASL%
\Wi .
SHIELDED CABLE
* Analog Outs no led ,ff
indicator
Qe * See the switch
or Dii Oles configutarion (OFF)
os 0 IC‘ 04 GND
030 p Oloz i | v 0-1W)
¥ AD.S
B
Mg e SHIELDED CABLE
NG D O tﬂ/
Ferrite KITA — o
GND
(=) ) POWER
224V } r ANALOG OUT

SHIELDED CABLE/J Dourioad the MOUINO LAYOUT: l\

Froem: svew, indusinialsiiedds com
"
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502 from
Phoenix contact. MC0,5/10-G-2,5THT

For 1/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference MC 0,5/10-G-2,5
THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension M-Duino 21 1/0s PLUS:

101

129
114

- DIN Rail mounting

Profilato o cappello TH 35-7,5 Profilato o coppello TH 35-15
Top hot rail TH 35-7,5 Top hat rail TH 35-15
15 5
o
155
-—~—| 1004
15°
RO8
R12
R 08
A e 120m
Sezione A / Section A R12
2,2 min. fino.a / To 2,5 max
R

2402

Sezione A/ Sedtion A

CARATTERISTICHE METODO ~ UNTA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PC/ABS METHOD PUABS

Mecconiche  Resisoza o tazieobosienomerto  JSTMD3E MR 68 Mechanicol test Resiconce o torslo stoss ot ASTIDE3B P 68
Resishin o tazione o witw JTMDB38  MPo 48 Tnsdastength ASTIDE3E b 48

Alungamenta a rattym JTMDB3E % 5 U o ASTIDE3B % 5

Modubo in fesions MTMDT0  MPo 269 Floing modulis ASTDT0 MR 269

Prova Lzad conintoglio 5018014 X 5 lrod st notched 15018014 Xm* 55

Termiche Teng di mma limento Vit meido B STMDISES °C L} Thermal test Vit sodhoring tamperatis mithod B ASTMDISS  °C 1
Tomperatum Ricoth 1 B1 MPy MSTMDBE  °C 97 Rebieting ‘o pratue 181 MPo ASTMD64B  °C 97

Fisiche Peso spafn XTAD79) g3 121 Physicol test  Spacic gmuity ASTMD79?  qoiemd L
R nelo stompo KIS % 04/04 Mould shithage ASTIDSS % 0406

Mk Flow Index 260°C - 98N SIMDIZ38  gi10° 111 Mt Fow Index 260°C - 98N ASTHD1238  qo/I0' 111
Comportamento Auestinguerea (i di pesoe) U - V-0(08) Flame test  Selfetinguisher (hidiess in ) 2] - V008
alla fiommo Fib handesen 37 mm 69521 °C 960 Incondescante thead 37 mm IEC69521  °C 960
Ialtronic si riserva il diritto di modificore il materiole con cui realizza i propri prodotfi Italtionic con operate any change of the moterials without being obliged to forewar.

senza obbligo di preowiso.

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 21 1/Os PLUS from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 21 1/Os PLUS. When configuring the layout of the M-Duino 21 I/Os PLUS inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage signal
wires and communications cables in the same tray with AC power wiring and high energy,
rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring M-Duino 21 1/Os PLUS. It is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25
cm above and below the devices. Also, allow at least 25 cm of depth between the front of
the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid-filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

48



Ref. IS.MDUINO.21+ Rev. 3:12-12-2024

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Revision Number

Date
30/08/2019
21/02/2019
12/01/2022
12/12/2024

Rev. 3:12-12-2024

Changes

First implementation
ETL Listing Mark-Direct added
Updated CE Normative (2004/108/EC)

Added section 3.4 (“Isolation Precautions”)
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com

Rev. 3:12-12-2024
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